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Staff Internet & Email Use Policy 
 
1 Overview 
 
The use of Email and the Internet has grown astonishingly quickly in recent years.  
Electronic mail has now become an established means of communication throughout 
the Institution to support the effective operation of all areas of the Institution.  Several 
factors combine to make email and the Internet a particularly important issue where 
the law is concerned.  These relate both to the social aspects, such as the way they 
are used and the perceptions surrounding them, as well as technological aspects 
relating to the power and flexibility of the technology.   
 
 
2 Introduction 
 
The Internet is a vast and expanding computer network that has the potential to 
provide substantial resources efficiently and economically for Education, Research 
and Services. Email is a very low cost and simple means of communication.  It 
frequently carries personal information, in the form of facts, intentions or opinions.  
Individuals often regard it as a private and confidential method of correspondence; 
however emails are not private and confidential unless specially encrypted.  Emails 
can be readily retransmitted to others, and can be distributed to a very large 
population with relative ease.  The result of these misconceptions, practices and 
attitudes regarding email is that users may use it inappropriately, or without really 
understanding the full implications.  The purpose of this policy is to outline to all users 
guidelines on Internet and email usage.  The policy will cover what is acceptable and 
unacceptable use, areas of responsibility i.e. individual, line managers and the 
Institution.  It also details how usage is monitored, consequences of misuse, and best 
practice when using the Internet and email.  The Policy will be made available to 
registered staff users of the Institutions Internet, email and related services and 
facilities.   
 
 
3 Responsibilities and Misuse 
 
The Joint Academic Network (JANET) is the collection of networking services and 
facilities, which support the communication requirements of the UK education and 
research community.  Edge Hill must ensure that unacceptable use of JANET does 
not occur by complying with JANET’s acceptable use policy.  Failure to comply with 
the JANET acceptable use policy may result in services being withdrawn from the 
Institution. 
 
Individual users are responsible for their own actions and therefore have the 
responsibility to follow these guidelines and ensure that they do not misuse Edge 
Hill’s Internet and email facilities.   
 
IT Services will be responsible for ensuring Heads of Services and Schools are 
aware of this policy, who in turn will be responsible for informing their staff of this 
policy.  
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Information & Media Services will be responsible for ensuring that all students are 
aware of this policy. 
 
IT Services are responsible for providing and maintaining central Internet and email 
systems and are responsible for this Internet and email policy.  
 
 
4 Acceptable Use 
 
Edge Hill’s main purpose in providing email and Internet access is to support the 
teaching, learning, research and approved business activities of the Institution.  
Internet and Email facilities provided by the Institution should therefore not be used 
for: 
 

• the creation or transmission of material that brings the Institution into 
disrepute.  

• the creation, download or transmission of material that is illegal.  
• the creation, transmission or download of material that infringes the copyright 

of another person, including intellectual property rights.  
• the unauthorised transmission to a third party of confidential material 

concerning the activities of the Institution.  
• the transmission of unsolicited commercial or advertising material, chain 

letters, or other junk-mail of any kind  
• activities that corrupt or destroy other users' data or disrupt the work of other 

users.  
• activities that waste staff effort or networked resources, or activities that serve 

to deny service to other users.  
• unreasonable or excessive personal use. (See section a below).  
• the creation, transmission or download or viewing of any offensive, obscene 

or indecent images, data or other material, or any data capable of being 
resolved into obscene or indecent images or material, other than for reasons 
specified in section b below. 

• the creation, viewing or transmission of material that is designed or likely to 
cause annoyance, inconvenience or needless anxiety.  

• the creation or transmission of material that is abusive or threatening to 
others, serves to harass or bully others, discriminates or encourages 
discrimination of others.  

• the creation or transmission of defamatory material or material that includes 
claims of a deceptive nature.  

• activities that violate the privacy of others or unfairly criticise, misrepresent, 
including copy distribution to other individuals.  

• the creation or transmission of anonymous messages or deliberately forging 
messages. 

 
a) Personal Use 

The Institution permits the use of its email and Internet facilities by staff and 
other authorised users for a reasonable level of personal use. 
 
Reasonable personal use: 
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• does not interfere with the performance of your duties;  
• is not detrimental to the main purpose for which the facilities are provided; 
• does not take priority over your work responsibilities;  
• is not of a commercial or profit-making nature, or for any other form of 

personal financial gain; 
• is not of a nature that competes with the Institution in business; 
• is not connected with any use or application that conflicts with an employee's 

obligations to the Institution as their employer; 
• is lawful and complies with the Institution’s rules, regulations, policies and 

procedures and in particular this policy; 
• does not incur unwarranted expense on the Institution; 
• does not have a negative impact on Edge Hill in any way. 
 
All personal e-mail must be filed in a folder marked “Personal” in your mailbox 
and archive and / or marked as “PERSONAL” in the subject line of the e-mail, 
further guidelines on individual personal use are available in Appendix C.  All 
other e-mail contained in your in-box, archive and sent items box are deemed to 
be business communications for the purposes of monitoring (See section 5). 

 
b) Research 

It is recognised that, in the course of their work or research, individuals of the 
Institution may have a requirement to view or receive material that would 
normally be defined as offensive, obscene, indecent or similar.  
In the case of properly supervised or lawful research purposes it is acceptable 
to do so, following the completion of Edge Hill’s Acceptable Use Policy Waiver 
form.  The Institution is legally responsible for the content and nature of all 
materials stored on/accessed from its network and therefore individuals must 
understand that this waiver form does not sanction the committal of acts that 
are illegal, including the viewing of child pornography.  The individual and 
their Dean of Faculty should complete this form before returning it to the Head 
of Research who will authorise the necessary access, for a limited period, if 
deemed appropriate. 

 
 
5 Email Monitoring and Proxy Access 
 
The message content of in-coming emails is automatically scanned to identify Spam 
otherwise Edge Hill do not actively monitor content.  However sometimes it will be 
necessary for Edge Hill to access your business communications during your 
absence.  Unless your mailbox settings are such that the individuals who need to do 
this already have permission to view your mailbox, access will be granted only with 
the permission of a Director, Head of Human Resources or relevant Head of Faculty 
or Service.  A member of staff granted proxy access must follow the guidelines in 
Appendix B “Guidelines on Proxy Access to Staff E-mail Accounts”.  An individual will 
be informed if access has been granted during their absence. 
 
Any e-mails which are not stored in your “Personal” folder and / or which are not 
marked personal will be treated, for the purpose of availability for monitoring, as 
business communications since Edge Hill will have no way of knowing that they were 
intended to be personal. 
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Individual users are responsible for arranging the management of their e-mails during 
absence from Edge Hill.  This can be managed by either the creation of automatic 
reply rules to notify staff that they are currently away from work or by organising 
proxy access for a colleague to manage your mailbox.  If automatic reply rules are 
used, the reply must include your expected return date and an alternative contact, if 
an earlier response is required.  For further guidelines see Appendix E “Managing E-
mails during Absence”.  Individuals must suspend all mail from any external mailing 
lists they have joined for the duration of their absence.  Rules created must only reply 
to the sender of the email.  If this has not been implemented this will be done for you 
following the granting of proxy access. 
 
Access to an email account will be granted as part of a criminal or disciplinary 
investigation.  In certain circumstances Edge Hill may, subject to compliance with any 
legal requirements, access e-mail marked “Personal”.  Examples are when Edge Hill 
has reasonable suspicion that they may reveal evidence of unlawful activity, including 
instances where there may be a breach of contract with Edge Hill. 
 
 
6 Email Storage and Logging 
 
Mail will be stored in an individual’s mailbox for a period of 90 days, unless previously 
deleted by the individual.  Following these 90 days it is moved into the trash folder.  
Mail in the trash folder is automatically emptied when it has been stored there for 7 
days.  Once an email is deleted from an account it is unrecoverable by the individual. 
 
The archive facility should be used for any messages that need to be kept for a 
longer period. 
 
IT Services automatically log all incoming and outgoing messages.  The details 
stored in these logs are whether the email is out or inbound, the date and time, the 
priority of the message, the sender and recipients’ email addresses, the subject of 
the email, the number of recipients, the number of attachments and size of 
attachments.  The logs do not store the content of the message.  These logs will only 
be used for system maintenance, statistical analysis, auditing or as part of a criminal 
or disciplinary investigation. 
 
These logs are retained for six months before being destroyed, unless required for 
use within criminal or disciplinary investigations. 
 
 
7 Personal Information and Standards 
 
Emails sent from staff are regarded as official communications from Edge Hill.  For 
this reason the same standards as alternative forms of communication should be met 
when writing an email.  Further information on e-mail communication standards can 
be found in Appendix A of this policy “Edge Hill’s Staff E-mail Etiquette Guidelines”, 
failure to follow these guidelines will be viewed as a breach of this policy and the 
Communications Policy. 
 
The sender of an email that contains personal information about an individual in the 
form of facts, intentions or opinions should be aware that if the individual makes a 
Subject Access Request under the Data Protection Act then this email would be 
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disclosed to them.  Emails should only be retained for as long as they are necessary, 
once they are no longer needed individuals should empty them from their accounts.  
Accumulating emails by neglecting to discard them is not good practice and could 
contravene the Data Protection Act. 
 
Individuals should be aware that email messages are vulnerable to security breaches 
during transmission as they can be intercepted, read, lost, redirected or even altered.  
Individuals are responsible for ensuring that emails are addressed correctly.   
 
 
8 Spam and Junk Mail 
 
Spam is an informal but widely used name for Unsolicited Bulk E-mail (UBE).  
Unscrupulous marketers and others send millions of copies of a message to 
addresses all over the Internet, causing inconvenience and fruitless work for end 
users and system managers of all kinds. 
 
Edge Hill has subscribed to the JANET subscription to the Mail Abuse Prevention 
System (MAPS) to filter out the majority of Spam and UBE.  Emails from addresses 
contained in the MAPS filter will be rejected by Edge Hill’s email system and returned 
to the sender.  E-mail arriving at Edge Hill is now scanned by software, which gives it 
a score reflecting the likelihood that it is SPAM.  E-mails suspected of being SPAM 
will still be delivered to the recipient, but will contain the text ***SPAM*** at the start 
of the subject line.  A text file will be attached to the e-mail explaining how the 
software identified the e-mail as SPAM.  It is the responsibility of the individual to 
filter these messages following the guidelines on Spam filtering (Appendix D) and to 
be careful of how they use their personal details on the Internet and mailing lists. 
 
 
9 Attachments, Downloads and Viruses 
 
The Institution provides a current and up to date virus checker on all networked 
computers.  It is the responsibility of the individual user to ensure that any file 
attachments sent via email have been checked for viruses using the Institution’s virus 
checker before transmission.  Individual users are also responsible for ensuring that 
any attachments received via email do not contain viruses before saving or opening.  
Caution should be used when opening any attachments or emails from unknown 
senders.  It is the responsibility of the individual user to ensure that any file 
downloaded from the Internet has been checked for viruses using the Institution’s 
virus checker and is from a reliable source 
 
IT Services will be responsible for ensuring that the virus checking software is 
maintained and kept up to date. 
 
File attachments greater than 10mb will not be accepted for transmission via email. 
 
 
10 Email Distribution Groups 
 
Registered users of the Institution’s email system can request email distribution 
groups to be set up by IT Services.  The individual requesting the set up of the group 
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will be responsible for notifying IT Services of any changes to membership of the 
group. 
 
 
11 Everyone Emails 
 
IT Services regularly receives requests to broadcast email messages to all users of 
the Institution (Staff and Students). The numbers of requests are increasing and if the 
majority of requests were actioned, this would lead to the clogging of users 
mailboxes. 
 
General requests for the broadcasting of Institution wide email messages will not 
normally be supported.  Some requests may be approved which are likely to be 
related to urgent Health & Safety issues, critical issues at the corporate level or 
issues relating to the misuse of facilities. 
 
Requests such as the publicity for courses/conferences, general publicity material, 
staff leaving, office closures should be forwarded to the IT Services helpdesk for 
inclusion in the weekly everyone email.  Submissions to this email must be received 
no later than 12pm on the Friday.  Staff should consider the use of the Institution’s 
Intranet or Internet site for advertising notices, events that can be linked to the 
weekly notices email. 
 
An electronic notice board is available for the advertisement of items for sale, wanted 
or lost items and general issues.   
 
Sending the same email to the Academic and Support staff distribution lists will be 
classed as sending to everyone and will be a breach of this policy. 
 
IT Services will be responsible for the distribution of everyone emails. 
 
 
12 Remote access 
 
Access is available off-site to the Institution’s email via a link from the Institution’s 
Internet site.  This is secured by individual email passwords. 
 
 
13 Edge Hill Web Pages 
 
The IT Services Web Services Team are responsible for maintaining and developing 
a range of web services across Edge Hill, including publication of the corporate 
Internet and Intranet sites.  The Team are responsible for the design and layout of 
the corporate web pages and work closely with Marketing to ensure the site reflects 
corporate branding, marketing campaigns and initiatives.  Departments, together with 
Marketing, are responsible for agreeing the content of their corporate web site pages. 
 
The Web Services Team also provide consultancy advice and support to those 
departments wishing to publish new information to the corporate site or develop their 
own departmental site. 
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Dean's of Faculty / Heads of Departments, or named approvers, are responsible for 
the content of their department’s web pages.   
 
Individual department website design templates must be approved by the Web 
Development Team, to ensure corporate guidelines have been followed and legal 
compliance (including SENDA, Accessibility, Data Protection, Copyright and 
Freedom of Information), before being published on the Edge Hill web site. 
 
 
14 Internet Use Monitoring and Logging 
 
IT Services automatically log access to the Internet.  The details stored in these logs 
are the IP address of the computer used, the date and time, the requested site and 
whether access was successful.   
 
These logs will only be used for system maintenance, statistical analysis, auditing or 
as part of a criminal or disciplinary investigation.  When used as part of a criminal or 
disciplinary investigation the logs will be cross-referenced with other network logs to 
identify the account used. 
 
For the purposes of maintaining your own personal privacy, you need to be aware 
that such monitoring may reveal sensitive personal data about you. For example if 
you regularly visit web sites which detail the activities of a particular political party or 
religious group, then those visits might indicate your political opinions or religious 
beliefs.  By carrying out such activities using Edge Hill’s facilities you consent to our 
processing any sensitive personal data about you, which may be revealed by such 
monitoring. 
 
These logs are retained for six months before being destroyed, unless required for 
use within criminal or disciplinary investigations. 
 
 
15 Downloads and Viruses 
 
The Institution provides a current and up to date virus checker on all networked 
computers.  It is the responsibility of the individual user to ensure that any file 
downloaded from the Internet has been checked for viruses using the Institution’s 
virus checker and is from a reliable source. 
 
IT Services will be responsible for ensuring that the virus checking software is 
maintained and kept up to date. 
 
 
16 Suspension of Access 
 
All staff therefore have the responsibility to follow these guidelines and ensure that 
they do not misuse the Institution’s Internet and email facilities.  
 
Where abuse has been identified or is suspected suspension of access to the 
Internet and email system will be implemented while the incident is investigated.  
Where it has been proven that abuse has occurred, formal disciplinary proceedings 
may be implemented.  
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Policy Edition: Version 3.1 (to be approved) 
May 2004 



APPENDIX A  Etiquette Guidelines 

 9

 
 
Staff E-mail Etiquette Guidelines 
 

1. Purpose 
The purpose of these guidelines is to outline the standards that are 
expected of all staff when using Edge Hill’s e-mail system. 

 
2. Ownership 

The e-mail system is the property of Edge Hill. It is provided to staff to 
support them in undertaking their roles and responsibilities.  The 
acceptable use of the e-mail system is set out in Edge Hill’s Staff 
Internet and E-mail Use Policy. 

 
3. Advantages of Using E-mail 

E-mail is a fast and effective way of delivering messages and 
documents both internally and externally.  Electronic methods of 
sharing information save time and other precious resources and enable 
staff to complete their tasks quickly and more effectively. 

 
Disadvantages of E-mail 
Due to the ease with which e-mails are transmitted staff can suffer from 
information overload.  Vital information may be lost amongst many 
irrelevant messages and valuable time may subsequently be wasted. 

 
4. Standards 

Whilst e-mail has the speed and apparent informality of using the 
telephone it also has the permanence of written communication. As 
such the standards of communication as identified in the Staff 
Communications Policy must be applied to e-mail communications. 

 
Communication Standards 

 Open, honest, professional and transparent 
 Accurate and timely 
 Clear 
 Two way 

 
For the purposes of these guidelines those standards should be 
applied to e-mail as follows: 

 
Standard – Open, honest, professional, transparent 

 
Confidentiality  
E-mail is not a confidential environment and should not be treated as 
such. Personal data and sensitive information should not be 
communicated by e-mail. In line with all contracts of employment all 
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staff must ensure the security of confidential information at all times 
including whilst using e-mail. 

 
Security and Storage  
The security and storage of e-mail messages may fall within the Data 
Protection Act particularly where there is reference to an individual’s 
personal information.  Messages should be deleted immediately they 
become obsolete and should be retained only if necessary in a secure 
system. 

 
Inappropriate Use  
Inappropriate use is detailed in the staff Acceptable Use and Internet 
and E-mail Use policies.  All staff using Edge Hill’s e-mail system 
should ensure they have read and understood these policies. 

 
Standard – Accurate and Timely 

 
Urgent or High Priority 
As there is no way of knowing when a recipient may be available to 
respond to an e-mail the system should not be relied upon to obtain an 
urgent or high priority response.  In such circumstances face to face or 
telephone methods of communication should be used.  Only use high 
priority or urgent on an e-mail when it is absolutely necessary.  

 
Factually Correct 
E-mail communications may be presented as evidence in formal 
internal procedures and in legal proceedings.  All data and information 
contained within an e-mail should be factually correct and should not 
be open to misinterpretation. 

 
Response Rates 
E-mail is the most popular form of communication within the institution.  
Many staff rely on it to enable them to work efficiently.  Response to e-
mails should be sent as soon as is reasonable.  Where it is not 
possible to respond immediately, an acknowledgement of the mail with 
an indication of when a response can be made should be sent. 

 
Time Wasting and Personal Use 
Staff may use e-mail for personal use providing this is done in their 
own time and no disruption to the work of the institution occurs as set 
out in the Internet and E-mail Use policy. 

 
 

Standard – Clear Communication 
 

Language 
E-mail messages should be appropriate in terms of language, tone, 
punctuation and grammar as with any other formal written 
communication. The structure and layout of the message should ease 
understanding and ensure there is no opportunity for misinterpretation.  
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Since reading from a screen is more difficult than reading from paper, 
the structure and lay out is very important for e-mail messages. Use 
short paragraphs and blank lines between each paragraph.  Be concise 
and to the point, do not make an e-mail longer than it needs to be.  
Remember that reading an e-mail is harder than reading printed 
communications and a long e-mail can be very discouraging to read. 

 
Proof Reading 
It is recommended that the sender checks the e-mail using system 
facilities such as the spell checker before sending the e-mail to ensure 
the message is both accurate and clear. 

 
Use a Meaningful Subject 
Try to use a subject that is meaningful to the recipient as well as 
yourself.  

 
 

Use of CAPITALS 
The sending of messages using capitals IS CONSIDERED TO BE 
SHOUTING and is not acceptable. 

 
Abbreviations 
Abbreviations should not be used unless the sender is certain that the 
recipient will fully understand them such as BTW (by the way).  The 
same goes for emoticons, such as the smiley :-). 

 
Standard – Two Way 

 
Copying E-mails 
E-mails should be copied only to those individuals who are required to 
take action as a result of the e-mail, require the information contained, 
or have asked to be kept informed. 

 
It is not appropriate to copy an e-mail to an individual’s line or senior 
manager in order to pressure an individual to treat the e-mail as more 
urgent or force a response. This could be considered a form of 
harassment. 

 
Forwarding E-mails 
It may be appropriate to forward an e-mail to delegate a task, request 
further information or legitimately keep a third party updated on issues 
that directly affect them.  

 
It is not appropriate to forward e-mails where there is the potential for 
this action to be malicious, disruptive or demotivating. Likewise, it is not 
appropriate to forward e-mails that have the potential to act against the 
interests of the sender, team, service or institution. 
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E-mail Circulation 
E-mails should only be sent to those recipients who will be directly 
affected by or need access to the information contained. Wherever 
possible the circulation of the e-mail should be limited. 

 
Junk Mail and Spam 
The generation, forwarding and copying of junk and spam mail is not 
acceptable.  By replying to spam or by unsubscribing, you are 
confirming that your e-mail address is 'live'.  Confirming this will only 
generate even more spam. Therefore, such incoming e-mails should be 
deleted immediately or use the e-mail facilities for automatically junking 
or blocking these. 

 
Training and Development 

 
It will be the responsibility of all line managers to ensure individuals 
and teams are provided with guidance in the application of these 
guidelines. 

 
It is the responsibility of all staff to raise any concerns with the 
application of these guidelines with the individual they feel may be in 
breach of them or with their line manager. 
 
 
Human Resources 
April 2004 
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Guidelines on Proxy Access to Staff E-mail Accounts 
 
Introduction 
 
Although Edge Hill e-mail facilities are provided for the purposes of business, teaching, learning 
and research, we allow staff a reasonable amount of personal use.  As outlined in the staff 
Internet and E-mail Use Policy this is permitted on condition that all the procedures and rules 
set out in this policy are complied with.  These guidelines have been written to assist managers 
who have to use proxy access to monitor staff communications during absence to comply with 
relevant legislation. 
 
 
Conditions for Personal Use 
 
The conditions for reasonable personal use set out in the Staff Internet and E-mail policy are: 
 

• does not interfere with the performance of your duties;  
• is not detrimental to the main purpose for which the facilities are provided; 
• does not take priority over your work responsibilities;  
• is not of a commercial or profit-making nature, or for any other form of personal financial 

gain; 
• is not of a nature that competes with the Institution in business; 
• is not connected with any use or application that conflicts with an employee's obligations 

to the Institution as their employer; 
• is lawful and complies with the Institution’s rules, regulations, policies and procedures 

and in particular this policy; 
• does not incur unwarranted expense on the Institution; 
• does not have a negative impact on Edge Hill in any way. 

 
 
Granting Proxy Access 
 
IT Services Helpdesk will only allow proxy access to a manager following written consent from a 
Director, Head of Human Resources, relevant Head of Faculty or Service or the individual 
themselves. 
 
On receipt of this written permission the helpdesk will grant access. 
 
An e-mail will be sent to the individual to notify them that access has been granted. 
 
 
E-mails Marked Personal  
 
Staff who choose to use Edge Hill’s e-mail facilities for personal use have been instructed to 
create a folder called Personal in their mailbox for the storage of personal e-mails and to 
arrange for personal e-mails to be marked Personal in the subject line of the e-mail. 
 
Managers who have access to a member of staff’s e-mail mailbox may not read items in the 
personal folder or e-mails marked personal unless as part of criminal or disciplinary action 
sanctioned by Human Resources. 
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E-mails Not Marked Personal  
 
E-mails that are not marked personal in the subject line or not stored within the personal folder 
may be considered as business communications and monitored during the member of staff’s 
absence. 
 
If on opening the e-mail it becomes obvious that the e-mail is personal then it must be closed 
immediately without further reading and moved to the personal folder. 
 
 
Access to Personal E-mails 
 
Please note that as detailed in the Staff E-mail and Internet Use policy, in certain circumstances 
Edge Hill may, subject to compliance with any legal requirements, access e-mail marked 
“Personal”.  Examples are when Edge Hill has reasonable suspicion that they may reveal 
evidence of unlawful activity, including instances where there may be a breach of contract with 
Edge Hill.  This will only be allowed if sanctioned by a Director or Human Resources. 
 
 
Relevant Legislation 
 

• Regulation of Investigatory Powers Act 2000 

• Telecommunications (Lawful Business Practice)(Interception of Communications) 
Regulations 2000) 

• Data Protection Act 1998 

• Human Rights Act 1998 

 

Regulation of Investigatory Powers Act 2000 (RIPA) 
Under RIPA it is unlawful for anyone “intentionally and without lawful authority to 
intercept, at any place in the United Kingdom, any communication in the course of its 
transmission”. 
This includes monitoring e-mail use at a content level during absence or criminal or 
disciplinary proceedings. 
 
Telecommunications (Lawful Business Practice)(Interception of Communications) 
Regulations 2000) 
These regulations provide another means of obtaining lawful authority to intercept 
business communications for one or more specified business purpose as specified in the 
Regulations. 
 
Data Protection Act 1998 
The Data Protection Act does not generally prevent monitoring but it sets out principles 
that apply when monitoring is carried out.  The most important of these concerns the fair 
and lawful processing of personal data.  In essence this is about openness and making 
staff aware of the nature, extent and reasons for monitoring. 
 
Human Rights Act 1998 
Article 8 of the Human Rights Act creates a right to respect for private and family life, 
home and correspondence. 
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Guidelines on Personal Use of E-mail 
 
Introduction 
 
Although Edge Hill e-mail facilities are provided for the purposes of business, teaching, learning 
and research, we accept that you may occasionally want to use them for your own personal 
purposes.  As outlined in the staff Internet and E-mail Use Policy this is permitted on condition 
that all the procedures and rules set out in this policy are complied with.  These guidelines have 
been written to assist staff who choose to use Edge Hill facilities for personal use. 
 
Conditions for Personal Use 
 
The conditions for reasonable personal use set out in the Staff Internet and E-mail policy are: 
 

• does not interfere with the performance of your duties;  
• is not detrimental to the main purpose for which the facilities are provided; 
• does not take priority over your work responsibilities;  
• is not of a commercial or profit-making nature, or for any other form of personal financial 

gain; 
• is not of a nature that competes with the Institution in business; 
• is not connected with any use or application that conflicts with an employee's obligations 

to the Institution as their employer; 
• is lawful and complies with the Institution’s rules, regulations, policies and procedures 

and in particular this policy; 
• does not incur unwarranted expense on the Institution; 
• does not have a negative impact on Edge Hill in any way. 

 
Privacy 
 
You need to be aware, however, that if you choose to make use of Edge Hill’s facilities for 
personal correspondence, you can expect very little privacy because Edge Hill may need to 
monitor communications during your absence due to illness, holidays and training or conference 
attendance. 
 
You will greatly increase the privacy of any personal e-mails by: 
 

• marking the subject line “PERSONAL” for e-mails you send and asking friends to mark 
any e-mails sent to you in the same way. 

 
• creating a folder within your e-mail mailbox and archive called “Personal”, and move all 

personal e-mails into this folder. 
 
If you do not mark your e-mails as personal and move them into a personal folder then during 
your absence all e-mails will be classed as business e-mails and will be monitored as we will 
have no way of distinguishing between business and personal e-mail. 
 
E-mails marked Personal  
 
Please note that as detailed in the Staff E-mail and Internet Use policy, in certain circumstances 
Edge Hill may, subject to compliance with any legal requirements, access e-mail marked 
“Personal”.  Examples are when Edge Hill has reasonable suspicion that they may reveal 
evidence of unlawful activity, including instances where there may be a breach of contract with 
Edge Hill. 
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Creating a Personal Folder 
 
To create a personal folder within your mailbox: 
 
Open your e-mail 
Select the File menu and choose New 
From the drop down list select Folder… 
 
The following screen will appear: 
 

 
 
Click Next 
 
In the following box type Personal in the Name box 
 

 
 
Click Next 
 
The following box will appear: 
 

 
 
Click Finish 
 
The “Personal” folder is now created within the 
cabinet of your mailbox. 
Moving Personal Items to the Folder 
 

To manually move a personal e-mail to this 
folder: 
 
Select the e-mail and using the mouse drag the e-
mail onto the personal folder, release the mouse and 
the e-mail will be deposited within the folder. 
 
Rules for Automatically Forwarding Personal E-
mail 
 
Open your e-mail account 
Select the Tools menu and choose Rules 
On the following screen: 
 

 
 
Select New on the right of the box 
 
The following box appears to set up the personal 
rule: 
 

 
 
In the Rule name box enter Personal 
Click on Define Conditions… 
 

 
 
Choose Subject from the drop down list 
(N.B. if subject does not appear on this list choose All 
fields and select subject from the box that appears). 
 
Enter Personal in the remaining box as detailed 
below: 
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Click OK 
 

 
 
Click Add Action 
 
Select Move to Folder… 
 
The following screen will appear: 
 

 
 
Click on the plus sign next to the cabinet to expand 
the cabinet and click on the box next to the personal 
folder to select it as shown below: 
 

 
 
Select Move 
 
The rule will now be set up as follows: 
 

 
 
Click Save 
 
Then select Close 
 

All e-mails that contain the word personal in the 
subject line will now automatically be forwarded to 
the personal folder. 
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Spam and Filtering Guidelines 
 
Introduction 
 
Over the past couple of years many of you have 
called our helpdesk asking if there is something we 
can do about all the junk and pornographic emails 
(Spam) you are receiving.  Until now Spam has been 
left up to you to identify and delete from your 
mailboxes, we have only been able to sign up to a 
service to filter Spam from known sources which has 
meant a large proportion has still got through to you.  
We have now identified and implemented a solution 
to this problem to help you identify and filter out 
Spam in your GroupWise mailbox. 
 
The Solution 
 
E-mail arriving at Edge Hill is now scanned by 
software called SpamAssassin, which gives it a score 
reflecting the likelihood that it is SPAM.  E-mails 
suspected of being SPAM will still be delivered to the 
recipient, but will now contain the text ***SPAM*** at 
the start of the subject line.  A text file will be 
attached to the e-mail explaining how the software 
identified the e-mail as SPAM.  This document 
suggests filtering rules to keep such e-mail out of 
your primary GroupWise mailbox. 
 
How SpamAssassin Works 
 
SpamAssassin works by automatically scanning the 
content of e-mails and their headers (subject, to, 
from, CC and BC fields).  During scanning it performs 
a number of tests, which scores the content and 
headers of the e-mail.  These tests look for common 
text and characteristics found in Spam, so the more 
tests failed the higher the score will be.  If the e-mail 
scores above a certain level the e-mail will be marked 
as Spam on the subject line. 
 
I Received Spam That Isn’t Marked 
 
If you receive an e-mail that is not marked as Spam 
that should have been, please forward this to the 
ITServices helpdesk.  This will allow us to use these 
e-mails to fine tune the Spam tests. 
 
Automatically Deleting SPAM 
(not recommended) 
 
Filtering rules could be set up to simply delete the 
message, but this is not advised because of the risk 
of messages being erroneously identified as Spam.  
It is safer to periodically look through a folder into 
which marked messages have been filed, checking 
for recognisable senders and/or subjects. 
 

How to Filter out the Spam E-mails 
 
Creating a Spam Folder 
 
To create a Spam folder within your mailbox: 
 
Open your e-mail 
Select the File menu and choose New 
From the drop down list select Folder… 
 
The following screen will appear: 
 

 
 
Click Next 
 
In the following box type Spam in the Name box 
 

 
 
Click Next 
 
The following box will appear: 
 

 
 
Click Finish 
 
The “Spam” folder is now created within the cabinet 
of your mailbox. 
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Creating the Spam Filtering Rules 
 
Once the Spam folder is created 
Select the Tools menu and choose Rules 
On the following screen: 
 

 
 
Select New on the right of the box 
 
The following box appears: 
 

 
 
In the Rule name box enter Spam 
Click on Define Conditions… 
 

 
 
Choose Subject from the drop down list 
(N.B. if subject does not appear on this list choose All 
fields and select subject from the box that appears). 
 
Enter SPAM in the remaining box as detailed below: 
 

 
 
Click OK 
 

 

 
Click Add Action 
 
Select Move to Folder… 
 
The following screen will appear: 
 

 
 
Click on the plus sign next to the cabinet to expand 
the cabinet, click on the box next to the Spam folder 
to select it as shown below: 
 

 
 
Select Move 
 
The rule will now be set up as follows: 
 

 
 
Click Save 
 
Then select Close 
 
All e-mails that contain the word Spam in the subject 
line will now automatically be forwarded to the Spam 
folder.  Remember to periodically check this folder for 
any erroneously marked e-mails. 
 
 
If you require any further help or advice please 
contact the ITServices Helpdesk on 4424 or e-
mail ITServiceshelpdesk. 
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Managing E-mails During Absence from Edge Hill 
 
Introduction 
 
The Freedom of Information Act 2000 now allows a right of access to information held by Edge Hill to the 
public.  Requests for Information can be received in writing via the post, fax or e-mail.  Any member of 
staff can receive requests for information and the requests do not have to be identified as Freedom of 
Information requests.  Once a request is received by Edge Hill we only have twenty working days to 
process it.  For this reason it is essential that all members of staff follow these guidelines to ensure that 
during absence from Edge Hill, whether through illness, special leave, holidays or conference 
attendance, all e-mail requests under the Freedom of Information Act are dealt with promptly. 
 
 
Step 1 
 
If you are a member of a mailing list such as the JISCmail lists, you must suspend your membership 
during your absence.  If you are concerned about missing any relevant e-mails you can search the 
archive of the list on your return. 
 
To suspend membership of all jiscmail lists you are on: 
 

Send an e-mail to jiscmail@jiscmail.ac.uk (not to your list) 

Leave the subject line blank 

In the message type: 

SET * NOMAIL 

Send the e-mail 

 
A confirmation e-mail will be sent to you confirming that all the lists you are registered with have been 
temporarily suspended. 
 
Step 2 
 
You must now: 
 

• arrange for a colleague to have proxy access to your account (See guidelines on 
Organising Proxy Access for a Colleague) 

or  

• set up an auto-reply rule that will notify the sender of any e-mail that you are 
currently unavailable and suggest an alternative contact for the person.  (See 
guidelines on How to set up an Auto-Reply) 
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Organising Proxy Access for a Colleague 
 
Before anyone can administer your mailbox you will 
need to grant him or her rights to access it.  This can 
be done by: 
 
Choose Tools from the menus and then Options 
The following dialog box appears: 
 

 
 
Double-click the Security Icon. 
 
The following dialog box appears: 
 

 
 
Click the Proxy Access tab once. 
 
The following dialog box appears: 
 

 
 
Enter the name of your colleague in the Name box 
(starting with their surname). 
 
Click Add User (their name will now appear in the 
Access List box underneath) 
 

 
 
Hi-light their name in the Access List box 
 
Select the Access rights you want to give them by 
clicking on the read and write boxes next to each of 

Mail\phone, Appointments, reminder notes and 
Tasks, as shown below: 
 

 
 
Selecting Read will allow the person to look at your e-
mails but not send e-mails from your account.  
Selecting Read and Write will allow them to look at 
your e-mails and respond to them from your account. 
 
Click OK. 
 
 
Managing Another Person’s Mailbox 
 
Proxying into the GroupWise Account for the first 
time 
 
In GroupWise select the File menu. 
Select Proxy 
 
The following screen will appear: 
 

 
 
In the Name box type your colleague’s name (start 
with their surname) 
 
Click OK 
 
You are now in your colleague’s mailbox.  The above 
steps only need to be completed the first time you 
proxy into their account. 
 
 
Returning to Your Own E-mail 
 
On the top left of the GroupWise screen click on the 
Proxy icon, as shown:  
 
Click on your name from the list that appears 
 
This returns you to your own mailbox 
 
 
Proxying Back into Your Colleague’s Mailbox 
 
On the top left of the GroupWise screen click on the 
Proxy icon as shown:  
 
Click on your colleague’s name from the list that 
appears 
 
This takes you back into your colleague’s mailbox. 
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How to set up an Auto-Reply 
 
Select the Tools menu and choose Rules 
On the following screen: 
 

 
 
Select New on the right of the box 
 
The following box appears: 
 

 
 
In the Rule name box enter Absence Reply 
 

 
 
Click Add Action 
 
Select Reply… 
 
The following screen will appear: 
 

 
 
Click the box next to include message 
 
Click OK 
 
On the next screen, enter your reply message to the 
individual. 
 

 
 
The message should state that you are currently 
absent from Edge Hill, your expected return date and 
an alternative contact if the sender requires a 
response before your return.  The contact details for 
an alternative recipient should include external 
contact details. 
 
For example 
 
 

I am currently away until 9th September 
and will deal with your e-mail on my 
return. 
 
If you require a response before my return 
please contact Louise Smith on 01695 
581111 or e-mail smithl@edgehill.ac.uk 

 
 
The rule will now be set up as follows: 
 

 
 
Click Save 
 
Then select Close 
 
All e-mails sent to you will now receive an automatic 
reply. 
 
 
 
If you require any further help or advice please 
contact the ITServices on 4424 or e-mail 
ITServiceshelpdesk. 
 
 


